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Introduction 

 
This Job Aid provides a detailed overview of the CONNECTIONS system changes and 
enhancements introduced for Quarter 4, 2008 (Q4-08). This Build is being implemented on 
January 23, 2009. The Job Aid is intended for CONNECTIONS users on different levels, and 
assumes familiarity with the CONNECTIONS System. As is true for all CONNECTIONS 
implementation reference materials, this Job Aid is available online on the CONNECTIONS 
intranet site: 
 

http://ocfs.state.nyenet/connect/jobaides.asp. 
 
Improvements to CONNECTIONS that are implemented periodically through SIRs and 
Change Requests are referred to as "Builds." Since these improvements are implemented on a 
quarterly basis, they are also being called Quarterly Improvement Plans referred to as Q1, 
Q2, Q3, and Q4.   
 
With the implementation of Q4-08, several changes will be introduced aimed at improving 
worker satisfaction with the system, ssiimmpplliiffyyiinngg  ddooccuummeennttaattiioonn,,  aanndd  rreedduucciinngg  aanndd,,  wwhheenn  
ppoossssiibbllee,,  eelliimmiinnaattiinngg  aarreeaass  tthhaatt  sseeeemm  rreedduunnddaanntt  oorr  ccuummbbeerrssoommee..    The majority of changes in 
Q4-08 are focused on improving navigation, streamlining data fields, and an overall look that 
is more intuitive to caseworkers. These changes are based on comments that have been 
received from front end users (caseworkers), OCFS field and ticket triage staff, along with a 
review of surveys, reports and other documentation.   
 
Please note that any visible identifying data in this Job Aid is simulated.  
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I.  Family Services Stage Improvements  
 

 
FASP - General Navigation Improvements (SIR 9134) 
 
A number of changes have been made in the FASP to save steps for workers and assist them 
in everyday system navigation.  These include:  
 
 
Check FASP Detail  
With Q4-08, the order of the incomplete components that are displayed on the Check FASP 
Detail and the Removal Update windows will match the order of these same components as 
they are displayed in the FASP tree.  This improvement will assist workers to more easily 
determine work to be done. 
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FASP Tree 
For an “In Process” FASP, the FASP tree will be expanded upon window entry displaying all 
sub nodes.  This display will eliminate numerous extra mouse clicks needed to expand the 
tree.   
 

 
 
 
Error Messaging Upon FASP Launch  
Error messages generated when launching a FASP or Plan Amendment have been combined 
in Q4-08.  Previously, the system would present messages sequentially.  The worker would 
need to correct one error before becoming aware of another, related problem. For example, 
when a worker would attempt to launch a FASP before completing the Family Relationship 
Matrix and the Primary/Secondary Caretaker, the system would display two separate error 
messages. 
   
Now, some messages have been combined, and related messages will be displayed together 
in a Message List.  Messages that require acknowledgement by clicking “OK,” such as in the 
example below, will be grouped together.  Additional secondary messages will also display 
based on the actions taken by the worker.    

:  
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FASP Due Dates (SIR 9135) 
 
The following changes have been made to the presentation of the FASP Due Dates in order 
to more clearly display the status and due dates in the FASP cycle. 
 
 
FASP Tree - “Due Date of the FASP”  
On the FASP tree, a “Due Date of the FASP” date will now be displayed for  FASPs in the 
following statuses: Not Launched, In Process and Pending (approval).  FASPs that have been 
approved will continue to display the approval date.  Please note that Rejected FASPs display 
as In Process.   
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“Next FASP Due Date”  
With Q4-08, the “Next FASP Due Date” field on the Family Assessment and Service Plan 
window will display the date of the earliest future “In Process” or “Not Launched” FASP.  
This change will result in more accurate information when there is an “In Process” FASP 
with a future due date.  Prior to Q4-08, the “Next FASP Due Date” field only reflected the 
next “Not Launched” FASP Due Date.  
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"FASP is OVERDUE" Message  
With Q4-08, the "FASP is OVERDUE" message will be displayed on the Family Assessment 
and Service Plan window only when the earliest of the “Not Launched” FASP, or the “In 
Process” FASP, is overdue.  
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 

1/14/09 7  



 
 
 
FASP Case Planner Summary Navigation (SIR 9157) 
 
With implementation of Q4-08, system navigation to the FASP will be streamlined when 
there is only a Case Manager, or a Case Manager and Case Planner, assigned to a FSS. 
Navigation from the FASP tree will now be directly to the Case Planner Summary windows 
as described below. Pre-Q4-08 navigation that supports the Case Planner compiling 
information recorded by multiple workers will remain available when a  CPS Monitor and/or 
Caseworker is assigned, or has contributed to the current FASP. Navigation has been 
streamlined as follows:    
 

• Navigation from the Family Update node to the Case Update tab will display the Case 
Planner Summary window, bypassing the Case Update window. Please note that this 
navigation is not supported if emergency services were chosen on the FSI and a 
program choice of protective does not exist, since the Case Planner Summary 
functionality is not supported in this  situation.   

 
• Navigation from the Assessment and Analysis node will display the Case Planner 

Summary window for the Family View tab (Child View tab in the CCR) bypassing 
the Family Assessment Analysis window as displayed below.    
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Closing this Case Planner Summary window will return the user to the Family 
Assessment Analysis window.  The user may then navigate as follows: 
 

o Choosing the Behavioral Concerns and Contributing Factors tab will display 
the Case Planner Summary window for that tab. 

o Choosing the Strengths tab will display the Case Planner Summary window 
for that tab.  

o Choosing the Needed Improvements and Changes tab will display the Case 
Planner Summary window for that tab.     
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• Navigation from Service Plan node to the Service Plan window, and clicking on 

the Family Involvement button will display the Case Planner Summary window. 
 

  

 
 
 

Note:  No change has been made in navigation from the Check FASP Detail window.  
Navigation back to Family Update, the tabs on Assessment and Analysis, or Service Plan, 
will return the user to the draft entry windows, not the Case Planner Summary window.  
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FSS - Education Tab (SIR 8983) 
 
Edits on the date field in the Education tab, that limited the entry date to the current or 
previous academic years, have been lifted in Q4-08. This change will provide caseworkers 
and education specialists with flexibility to record pertinent information as soon as it 
becomes available.  The date drop-down on the Education Detail window will now allow 
selection of current academic year, a previous year, and the next academic year.  The system 
will default to the current year.  
 

 
 
 
 
Note:  Since Effective Date is used by the system to determine access to historical 
information, workers who record future information for an upcoming year, who are then end-
dated prior to the start of that year, will be unable to view that recorded information.  
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II.  Approvals  
 
Approval Readiness (SIRS 9139, 9298) 
 
With implementation of Q4-08, changes have been made in the approval process to assist 
Case Managers when work requires multiple levels of approval. This modification applies to 
approval To-Do’s for the FASP, Plan Amendment, Removal Update, Stage Closure, and 
Family Services Safety Assessment.  
 
Approval To-Do’s that are not ready to be approved by a Case Manager will now appear 
grayed out on the Manager’s To-Do List.  The Detail and Navigate push buttons on a grayed 
out To-Do can be accessed by the Case Manager at any time. When initial approval is 
complete, and the work is ready to be approved by the Case Manager, the To-Do will no 
longer appear gray. 
 
If work is rejected by the first level approver, the Case Manager’s approval To-Do will be 
automatically deleted, and a system generated alert will be sent informing the Case Manager 
that the Task has been rejected.  
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III.  Permanency Hearing Report  
 
Permanency Tab – Hearing Date Certain (SIR 9131) 
 
With implementation of Q4-08, modifications have been made on the Child List Grid and the 
PHR Summary Grid to assist the worker when a Hearing Date Certain recorded in CCRS is 
subsequently updated. 
 
The “Hearing Date Certain” label on the Child List Grid has been changed to “Hearing Date 
Certain from CCRS,” and a checkbox titled “Amended Date Certain”  has been added to the 
Summary Grid.  The checkbox will pre-fill if the “Hearing Date Certain” is changed on the 
Court Information window in CONNECTIONS, clarifying why the “Hearing Date Certain 
From CCRS” (top grid) may be different from the “Hearing Date Certain” (bottom grid).  
Q4-08 will not impact the Hearing Date Certain recorded in CCRS.  CCRS remains the legal 
system of record, and it is important to keep it current.  
 
 
 

 
 
 
 
 

1/14/09 13  



 
 
 
 
IV.  Progress Notes 

rogress Notes Search Window-New Using and Sort Functions 

ith implementation of Q4-08 the “New Using” option will be placed directly on the 

he “Sort” function will also be enhanced to allow sorting directly on the Progress Notes 

 
 
P
(SIR 9145) 
 
W
Progress Notes Search window, replacing the “Sort” pushbutton.  The “New Using” option, 
which offers the worker an efficiency by allowing data fields in an existing note to be used in 
a new note, has been underutilized by workers since the option has not been viewable on the 
Progress Notes window.  
 
T
Grid in ascending or descending order. The worker can modify the default sort order 
(descending by date) by clicking on a column heading in the Search Results grid.  This will 
sort by the selected column in ascending or descending (alpha or numeric) order. When a 
column is sorted in ascending order, an upward pointing arrow will display in the column 
heading. For descending, a downward arrow will display.  The “Sort” options available prior 
to Q4-08 will also still be available under the “Options” menu.  
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Progress Notes Entry Based on CID (SIR 8459) 
Q4-08 will provide additional flexibility in the recording of progress notes.  For progress 
notes entered in FSS Stages (Stage Type CWS and ADVPO), the system will allow recording 
of a progress note with an event date based on CID, when the CID is prior to the date of the 
Family Services Intake (FSI). Progress Notes Event Dates can now be as early as the earlier 
of the CID, or the date of FSI (initial Save).   
 
A new error message will display if  the CID Date is earlier than the FSI,  and a worker 
attempts to record a progress note with an Event Date prior to the CID date:  
 
“The event date must not be prior to the Case Initiation Date.  Please change the event date 
of the progress note.”   
 
 
 

.  Investigation StageV  

PRS -  Investigation Actions Checklist (SIR 9133)  
ith implementation of Q4-08, districts can decide whether to require the Investigation 
ctions checklist included in the submission of Investigation Conclusion for approval.  Some 

Checklist is redundant with local 

r to require completion of the Investigation 

tions Checklist, 

ed on the approval of the Investigation Conclusion.  

istricts opting to discontinue the Investigative Actions checklist requirement can notify 
CFS CONNECTIONS Regional Implementation staff in advance of the Q4-08 

cision can also be made after implementation, by  contacting the 
me staff at any time and will be implemented in a relatively short period once OCFS has 

 
C
W
A
local districts have reported that the Investigation Actions 
procedures and practices. 
 
If a district determines that Investigation Actions will no longer be required, the Investigation 
Actions Task will remain on the INV Stage Task List, but the system edit that requires the 
checklist in order to submit the Investigation Conclusion for approval will be lifted.  This 

ill allow supervisors to determine whethew
Actions on a worker specific basis. 
 

egardless of whether a district requires completion of the Investigation AcR
the Investigation Actions “Event” will continue to be system generated on the Investigation 
Stage Event List. The status of the Event will be updated to “PEND” (Pending) and 
APRV”(Approved) bas“

 
D
O
implementation date.  The de
sa
been notified.  
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CPRS – Local Notes Tab - ACS Local Protocol (SIR: 9155, 9156) 
(ACS ONLY) 
In Q4-08, the ACS Local Protocol Template (CPRT) has  been streamlined in order to 

e Q4-08 implementation date.  

I.  System Messaging

remove areas of  redundancy between the Local Protocol and CONNECTIONS Progress 
Notes.  Any instructions applicable to Progress Notes have been moved to the Progress Notes 
Tab. This includes Local Protocol questions regarding “Child’s Account” and “Parent’s 
Account”. 
 
The following topics, not required elsewhere in CONNECTIONS, will remain in the ACS 
Local Protocol: Child Under the Age of 1,  Sex Abuse and Domestic Violence Protocols.      
 
Implementation Note:  The new CPRT will be available for local protocols that are initially 
accessed after th
 
 
V  

Save” Messages ( SIR: 9149) 
ith implementation of Q4-08,  the pop-up window “Changes Have Been Saved” has been 
moved.  This pop-up was presented in Progress Notes upon selection of Save as Draft, 

ent or Risk 

he worker to cancel the FINAL save of a progress note and then save the note as 

 
“
W
re
Save as Final, or Save and Enter New, as well as when a Safety Assessm

aved in the INV stage.  The message was found to be of little value to Assessment was s
workers, however, since the only option available upon its presentation was to click ‘OK’.  In 
Progress Notes, there was no option for the worker to “back out” of saving a Final Note to 
the database. 
 
A new message (below) has been added when “Save as Final” is selected. This new message 

ill allow tw
DRAFT instead.     
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VII.  Foster and Adoptive Home Development (FAD)  

 

urrently,  users who don’t have access to the FA Home License window cannot determine if 
a resource is a subsidy home.  To address this,  an Adoption Subsidy checkbox has been 
added on the Resource Detail window (example below). This checkbox will be system 
checked if Subsidy is checked on the FA Home License window.  
 

 
FAD Resource Directory/ Detail Window - Adoption Subsidy Checkbox  
(SIR 6506) 
 
C

 
 
 
FAD Closure Reason – Mandatory Disqualifier (SIR 9333) 

he Adam Walsh Child Protection Act of 2006 requires, effective October 1, 2008, 
mandatory revocation of foster/adoptive parents certification/approval or disqualification of 
foster/adoptive applicants when convicted of certain categories of felonies.  To support 
recording this in CONNECTIONS, a new code, “Criminal History - Mandatory 
Disqualifier”, has been added to the drop-down closure reasons on the FAD Close Home 
window. “Criminal History – Presumptive  Disqualifier” remains on the list, but is not to be 
used as of October 1,2008.  
 
 
 
 
 

T
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Support Tools 

Online Help 
 
CONNECTIONS Online Help provides descriptions for various windows, as well as step-by-
step instructions for common tasks. You can access Online Help at any time, from any 
window in CONNECTIONS by clicking on the Help menu or pressing the F1 key on your 
keyboard.  The Contents, Index and Search tabs in Online Help allow you to search for and 
navigate to the topic(s) on which you need help. 
 
To Access Online Help: 

1. Click on the Help menu on the CONNECTIONS Toolbar. 

information on various fields. 
DSS Policy Online OCFS policy handbooks (under revision). 
Help On This 
Window 

Window description help for the window you are on. 

Help for Help Instructions on how to use the help functionality. 
About 
CONNECTIONS

Information about the current CONNECTIONS version 
and build. 

2. Click on a command from the Help menu. 
indow related to your selection displays. In some cases, you will need to 
nother selection in that window to obtain instructions. At the top of 

each window you will see additional buttons and menus. Use the Search 
button to search for specific information in the Help function and use the 
Back button to return to windows you have just visited in Help. The Glossary 

 

The following list of commands displays: 

Contents A table of contents for the help facility with links to major 
sections. 

How Do I? Step-by-step instructions to help you complete tasks using 
CONNECTIONS. 

Window 
Descriptions 

Descriptions of windows in CONNECTIONS, along with 

The w
make a

button opens a list of important CONNECTIONS terms and the Print button 
allows you to print Help information. 

3. When you are done reviewing information in Help, close each Help window 
by clicking on the Close button ( ) in the top right corner of the window.  
The system returns to the window you were using when you accessed Help. 

 

1/14/09 18  



 
 
 
 
 
OCFS CONN  Intrane
 
A variety of training-related ma
intranet site (http://ocfs.state.nyenet/connect/). The intranet site contains a wealth of 
information r arious as
Alerts and No Step G  
Step-By-Step Guide), Job Aids an (FAQs). Release Notes—a 
complete list ications is also 
available from

Accessing the CT

1. our local des

2. s the OCFS intranet site automatically, enter 
dress line and press the Enter key 

3. 

4. 

ase Notes for Q3-08, click on the 

5. 

Enterprise Help Desk 

he New York State Office for Technology (NYS OFT) Enterprise Help Desk staff is 
vailable to answer basic questions related to your equipment or to solve problems you are 
aving with the CONNECTIONS application. If they cannot solve your problem, they will 

 others who can. 
our agency may have procedures in place for contacting the Enterprise Help Desk. Check 

e Help Desk. 

ECTIONS t Site 

terials are available from the OCFS CONNECTIONS 

elated to v
tices, Step-by-

pects of CONNECTIONS, including training schedules, 
uides (including the CONNECTIONS Case Management

d Frequently Asked Questions 
of the modif , enhancements, fixes and impacts in the Build—
 the CONNECTIONS intranet site. 

 OCFS CONNE IONS Intranet Site 

From y

If the browser doe

ktop, double-click on the Internet Explorer icon. 

not display 
http://ocfs.state.nyenet into the browser’s ad
on your keyboard. 
The OCFS intranet home page displays. 

Click on the CONNECTIONS link. 
The CONNECTIONS home page displays. 

Click on a topic to access information. For access to various Step-by-Step 
Guides and Job Aids, click on the Step-by-Step/Job Aids/Tips link. For 
access to Quarterly Improvement Rele
Implementation link. 

To close Internet Explorer, click on the File menu and select Close. 
 

 
T
a
h
record your information and forward it to
Y
with your supervisor before you call. 
 
The Enterprise Help Desk is staffed 24 hours a day, seven days a week. The telephone 
number is:  1-800-NYS-1323  (1-800-697-1323). 
When you call the Enterprise Help Desk with a problem, you will be given a ticket number to 
use for tracking your issue and its resolution. Keep a record of this number; you will need it 
for any follow-up conversations with the Enterpris
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App Help 
 
In addition to rise Help Desk with application issues, district staff can 
directly contac rt/Triage staff for help with complex 
application  can now be emailed to:  
ocfs.sm.con

Mailbox 

 calling the Enterp
t the NYS CONNECTIONS User Suppo

 issues. Questions, problems and concerns
n_app@ocfs.state.ny.us

 
The ‘App H  for 
questions that t in 
CONNECTIO h you 
have unsucces om your supervisor or a Resource User, it would be 
appropriate in-agency 
resources should always be your first contact when trying to resolve an issue. 
 

elp’ mailbox is intended to provide an expanded level of support. It is meant
 have had an initial review by agency staff who are proficien
NS (e.g., Resource Users). For example, if you have an issue for whic
sfully sought advice fr

 to contact the App Help mailbox with the issue. However, your 
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